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Abstract

K-mer based comparisons have emerged as powerful complements to BLAST-like alignment
algorithms, particularly when the sequences being compared lack direct evolutionary
relationships. In this chapter, we describe methods to compare k-mer content between groups of
long noncoding RNAs (IncRNAs), to identify communities of IncRNAs with related k-mer contents,
to identify the enrichment of protein-binding motifs in IncRNAs, and to scan for domains of related
k-mer contents in INcRNAs. Our step-by-step instructions are complemented by Python code
deposited in Github. Though our chapter focuses on IncRNAs, the methods we describe could be

applied to any set of nucleic acid sequences.



1) Introduction

Upwards of 80% of the human genome can be transcribed into RNA. Of the total number of
transcribed nucleotides, approximately one half comprise pre-messenger RNAs (pre-mRNAs)
that will ultimately become spliced and encode for proteins in the cytoplasm. The other half
comprise long noncoding RNAs (IncRNAs), defined as RNA species that are greater than 200
nucleotides in length and have little or no potential to encode for proteins. Compared to transcripts
produced from protein-coding genes, IncRNAs are, on average, less conserved, transcribed at
lower levels, spliced less efficiently, and more likely to remain in the nucleus [1-6].

Nevertheless, a growing number of INcRNAs have been studied experimentally, and are now
known to play important roles in health and development. Some of the most notable of these
include the IncRNA XIST, which orchestrates transcriptional silencing during X-chromosome

Inactivation [7], the IncRNAs NEAT1 and MALAT1, which play roles in nuclear organization and

have context-dependent functions in development and in cancer [8—14], and the IncRNA NORAD,
which helps to maintain genome stability by promoting DNA repair [15, 16]. LncRNAs have also
been found to play important roles in developmental transitions [17-23], in the immune system
[24-26], in the brain [27-33], and in the heart [34—-37]. These identified roles, coupled with the

large number of INncRNAs that have yet to be studied experimentally, suggest that IncRNAs with
important physiological functions remain to be discovered.

Still, identifying function in IncRNAs remains a major challenge. Many IncRNAs are thought to
function as hubs that concentrate proteins, DNA, and possibly other biomolecules in particular
regions of the cell, yet the sequence characteristics that give rise to these functions and the
mechanisms through which they occur are poorly defined, even for the best studied INcRNAs [38—
42]. Moreover, relative to protein-coding genes, INncRNAs are poorly conserved, evolve rapidly,
and are prone to changes in gene architecture, limiting the extent to which traditional phylogenetic

analyses can be employed to identify the sequence features that are important for specifying their



function [43]. As an example, placental mammals express the XIST IncRNA to orchestrate gene

silencing during X-Chromosome Inactivation [7], while marsupial mammals independently

evolved their own IncRNA to orchestrate X-Chromosome Inactivation, termed Rsx. Remarkably,
XIST and Rsx share no significant similarity by standard methods of sequence alignment [44, 45].
Thus, even though Rsx and XIST presumably function through analogous mechanisms, standard
tools of sequence comparison are unable to detect the analogy. This problem extends to all
IncRNAs. The sequence patterns that specify recurring functions in IncRNAs are largely unknown
and difficult to detect computationally. Thus, to date, IncRNA functions must be determined
empirically, on a case-by-case basis.

Recently, we developed a method of sequence comparison based on the notion that different
IncRNAs likely encode similar functions through different spatial arrangements of related

sequence motifs, and that such similarities might not be detectable by traditional methods of linear

sequence alignment [46]. In our method, which we termed SEEKR (sequence evaluation through

k-mer representation), the sequences of any number of IncRNAs are evaluated by comparing the
standardized abundance of nucleotide substrings termed “k-mers” in each IncRNA, where k
specifies the length of the substring being counted, and is typically set to values of k =4, 5, or 6.
SEEKR counts k-mers independent of their position in sequences of interest, much like the “bag

of words model” used by many language processing algorithms, in which sentences are classified
by word abundance without regards to grammar or syntax [47]. Using SEEKR, we demonstrated
that k-mer content correlates with IncRNA subcellular localization, protein-binding, and repressive
function, and that evolutionarily unrelated IncRNAs with analogous functions shared significant
levels of non-linear sequence similarity even when BLAST-like alignment algorithms could detect
none [46].

Below, we walk users through five related applications of SEEKR that we have found to be

useful. For each application, we enumerate step-by-step instructions. Where relevant, we include



code to execute specific functions in python. We have deposited standalone python code to run
the major applications of SEEKR in Github (https://github.com/CalabreselLab/seekr). For the
simplest implementation of SEEKR, we refer users to a web portal (http://seekr.org). K-mer based
classification schemes have been used in many biological contexts ([48-56] and others).
Therefore, beyond IncRNAs, the methods that we describe should prove useful in the study of
other nucleic acid sequences, such as 5' and 3' untranslated regions of mMRNAs and DNA

regulatory elements.

2) Materials

2.1) Hardware Requirements

Personal computer, preferably with a multi-core processor and at least 8GB of RAM.

2.2) Software Requirements

1. Python >=3.6. The easiest way to get started with Python is by downloading the Anaconda

distribution: https://www.anaconda.com/download.

2. The python packages: numpy, pandas, networkx, python-igraph, louvain. All of these can be
installed by running $ pip install [name].

3. R, which can be installed from https://www.r-project.org/.

4. The R packages amap and ctc. amap is hosted at https://cran.r-

project.org/web/packages/amap/index.html, and ctc at

https://bioconductor.org/packages/release/bioc/html/ctc.html. Both can be installed by running:

and can be installed by running:
source("http://bioconductor.org/biocLite.R")
biocLite("amap")

biocLite("ctc")

5. Java 1.8. See this page for help installing java:

https://www.java.com/en/download/help/download_options.xmi



6. Java Treeview. http://jtreeview.sourceforge.net/

7. Gephi, which can be installed from https://gephi.org/users/download/.

8. SEEKR (optional). SEEKR is hosted at pypi: https://pypi.org/project/seekr/, and can be
installed by running $ pip install seekr. SEEKR works on Mac and Linux. As of the time
of publication, there is a bug installing several dependencies of SEEKR if using Anaconda
Python on MacOS. As a workaround in macOS 10.14.x, run $

MACOSX DEPLOYMENT TARGET=10.14 pip install seekr. To print the documentation
associated with each SEEKR command line tool, simply type the name of the tool in the UNIX

terminal (e.g. $ seekr download gencode).

3) Methods
3.1) Comparing k-mer contents between a group of IncRNAs
3.1.1 Download IncRNA sequences

LncRNA sequences can be downloaded from https://www.gencodegenes.org/. For this analysis,

we'll use human v22:

ftp://ftp.ebi.ac.uk/pub/databases/gencode/Gencode human/release 22/gencode.v22.IncRNA tr

anscripts.fa.gz

and mouse v5:
ftp://ftp.ebi.ac.uk/pub/databases/gencode/Gencode _mouse/release M5/gencode.vM5.IncRNA _t
ranscripts.fa.gz. Unzip these files to produce gencode.v22.IncRNA_transcripts.fa and
gencode.vM5.IncRNA _transcripts.fa.gz. The following pipeline will be demonstrated using just
the gencode.v22.IncRNA _transcripts.fa file. Mouse, or any other fasta file, can be substituted

instead.



Downloading and unzipping can be done manually. Alternatively, if SEEKR is installed locally,
you can also download the files from the command line. Use “IncRNA” to specify the biotype of
transcripts file, and the “--release" flag to indicate you want a particular version of the fasta file:

$ seekr download gencode 1ncRNA -r 22

3.1.2 Select 01 isoform
To avoid bias that may be introduced by counting k-mers across multiple isoforms of the same
transcript, we typically only select transcripts ending in 01, which in prior versions of GENCODE,
represented the canonical isoform of a gene product. Using this filter, each genomic locus is only
represented once.
fasta path = 'v22 IncRNA.fa' (see note 1)
with open(fasta path) as infasta:

data = [l.strip() for 1 in infasta]

headers = data[::2]

seqgs = data[l::2]

fastall path = 'v22-01.fa'
with open(fastal0l path, 'w') as outfasta:
for header, seq in zip (headers, seqgs):
common name = header.split('|"') [4]
if common name.endswith('01'): (see note 2)
outfasta.write (header+'\n")

outfasta.write (seg+'\n'")

To accomplish the same using the command line tool, pass seekr canonical gencode the

name of the GENCODE fasta file and a path to the newly filtered fasta file:



$ seekr canonical gencode v22 1ncRNA.fa v22-01.fa

3.1.3 Count k-mers

Next, we define a 2D matrix where each row represents one transcript, each column represents
a k-mer, and each element is a normalized and standardized count of how many times a k-mer is
found in a transcript. A single row of the matrix, then, defines a “k-mer profile” for a given IncRNA.
import pickle

import numpy as np

import pandas as pd

from collections import defaultdict

from itertools import product

# Read fasta file

fasta path = 'v22-01.fa'

with open(fasta path) as infasta:
data = [l.strip() for 1 in infasta]
headers = data[::2]

seqgs = data[l::2]

# Initialize data

k=6

kmers ['"".join (i) for i in product ('AGTC', repeat=k)]

k map = dict (zip(kmers, range(4**k)))

counts = np.zeros([len(seqgs), 4**k], dtype=np.float32)



# Do counting
for i, seqg in enumerate (segs):
row = counts[i]
count dict = defaultdict(int) (see note 3)
length = len(seq)
increment = 1000/length
for ¢ in range (length-k+1): (see note 4)
kmer = seqg[c:ctk]
count dictlkmer] += increment
for kmer, n in count dict.items():
if kmer in k map: (see note 5)

row[k map[kmer]] = n

# Normalize

counts —-= np.mean(counts, axis=0)

counts /= np.std(counts, axis=0)

counts += abs(counts.min()) + 1 (see note 6)

counts = np.log2 (counts)

# Save csv file

out path = 'v22-émers.csv'
seen = set () (see note 7)
names = []

for h in headers:
name = h.split('|"') [4]

if name in seen:



name += 'B'
seen.add (name)
names.append (name)
pickle.dump (names, open('v22 names-B.pkl', 'wb'))
df = pd.DataFrame (counts, names, kmers)

df.to csv(out path, float format='%.4f')

Using the command line tool:

$ seekr kmer counts v22-0l1l.fa -o v22 6mers.csv

3.2) Hierarchical clustering of IncRNAs by k-mer content

3.2.1 Cluster with amap

The visualization tool Java Treeview allows for interactive exploration of large hierarchical
clusters. Treeview parses clusters defined by a set of three plaintext files, which describe the
structure of row and column clusters: .gtr, .atr, and .cdt. These files can be conveniently produced
by the R packages "amap’ and “ctc’, which parse a .csv file such as v22_6mers.csv. The R script

‘treeview_cluster.r’ will create the Treeview files:

make treeview <- function(csv, out gtr, out atr, out cdt) {

library (amap)

library(ctc)

kmers <- read.csv(csv, header=TRUE, row.names=1)

kmers <- round(scale (kmers, scale=FALSE), 6)

# Generate distance matrix using pearson distance



dist mat <- Dist (kmers, method="correlation", nbproc=4)

dist mat trans <- Dist(t(kmers), method="correlation", nbproc=4)

# Clustering using average agglomeration method
clust row <- hclust(dist mat,method="average")

clust col <- hclust(dist mat trans,method="average")

# Exporting the gtr, atr and cdt files

r2gtr(clust row, file=out gtr, distance=clust row$dist.method,
dec="'."', digits=5)

r2atr(clust col, file=out atr, distance=clust col$dist.method,
dec="'."', digits=5)

r2cdt (clust row, clust col, kmers, labels=FALSE, description=FALSE,
file=out cdt, dec='.")

}

args <- commandArgs (trailingOnly = TRUE)

do.call (make treeview, as.list(args))

While this script is not part of the seekr module, it can be called from the command line using:
$ Rscript treeview cluster.r v22 6mers.csv v22 6mers.gtr v22 6mers.atr

v22 6mers.cdt

3.2.2 Visualize in java treeview



Launch Treeview, and give Java access to plenty of memory. If insufficient memory is allocated,
Treeview will not be able to open the .cdt file. Starting Treeview with 14GB of memory can be

done by:

$ java -Xmx14000m -jar ~/Downloads/Setups/TreeView-1.1.6r4-
bin/TreeView.jar

Substitute the correct path to your TreeView.jar file. Once started, open v22-6mers.cdt via "File"
-> "Open". After the file is loaded, change the visualization settings by: "Settings" -> "Pixel
Settings...". Find the "Global" section of the pop-up window. Click "Fill" for both "X" and "Y". In the
"Contrast" section, set "Value" to 1. In the "Colors" section click "YellowBlue". Close the pop-up
window.

The image can be saved by "Export" -> "Save Thumbnail Image" -> "Save".

An ordered list of all transcript names can be exported as well. To do so, you must first select all
transcripts. The easiest way to do this is to click on the far left of the dendrogram, so that a portion

of the transcripts are highlighted in red. Hold down the up-arrow until all transcripts are highlighted

in red. Then click "Export" -> "Save List" -> "Save".

3.3) Identifying communities of IncRNAs with related k-mer contents

It takes several steps to convert k-mer profiles into the form needed for identifying communities.
We first build an adjacency matrix, describing all pairwise relationships between all IncRNAs, then
use the matrix to build a network of IncRNAs. Finally, we can use a network algorithm to assign

a community label to each IncRNA.

3.3.1 Build adjacency matrix
First, we need to build an adjacency matrix. This matrix describes how similar each IncRNA is to

all other IncRNAs, as measured by their Pearson’s r-values.

import pandas as pd



import numpy as np

counts = 'v22 omers.csv'

counts = pd.read csv(counts, index col=0)

adjacency = np.corrcoef (counts.values)
adjacency = pd.DataFrame (adjacency, counts.index, counts.index)
adj path = 'v22 adj.csv'

adjacency.to csv(adj path, float format='%.4f'")

To calculate our adjacency matrix, we want to compare our k-mer counts file against itself. The
seekr command line tool is capable of comparing two separate counts files, so in this case, we
need to pass our counts file twice:

$ seekr pearson v22 6mers.csv v22 6mers.csv -o v22 adj.csv (see note

8)

3.3.2 Sparsify the matrix

To decrease the runtime of community calculation, we can reduce the number of edges in the
network, by sparsifying the adjacency matrix by thresholding below a limit. That is, if the Pearson's
r-value between two transcripts is less than the limit, we set that element of the matrix to 0, which
removes that edge from our network. However, there is no single best threshold value; it depends
heavily on the specific experiment and factors such as the k-mer size used. For example, smaller
k-mer sizes will likely need higher thresholds. Therefore, it may be worthwhile to test multiple
thresholds. One possible guideline is the mean and standard deviation of the r-values in the
adjacency matrix. Two standard deviations above the mean (i.e. the 95" percentile in a normal

distribution) is one viable threshold, and easy to compute. In our original publication of SEEKR,



we used 0.13 as a threshold, which is what we will use here, but we will also demonstrate how
one would calculate a reasonable threshold de novo:
import pandas as pd

import numpy as np

adj = 'v22 adj.csv'

adjacency = pd.read csv(adj, index col=0)

print (adjacency.values.mean () + 2*adjacency.values.std())
limit = .13 (see note 9)

np.fill diagonal (adjacency.values, 0) (see note 10)
adjacencyladjacency < limit] = 0

new adj = 'v22 adj pl3.csv'

adjacency.to csv(new adj, float format='%.4f"')

In addition to calculating the mean and standard deviation, you can quickly visualize the
adjacency matrix from the command line. This will create a pdf file that contains a graph of the
distribution of all elements in the adjacency matrix and markings denoting the mean of the
distribution as well as one and two standard deviations above the mean. Empirically, we have
found that a Pearson’s r value of two standard deviations above the mean provides an intuitive

threshold that can be used to sparsify any adjacency matrix:

$ seekr visualize distro v22 adj.csv v22 adj.pdf

3.3.3 Convert adjacency matrix to network and find communities
Once the sparse adjacency matrix has been made, communities can be called with the Louvain
algorithm. To use the Louvain algorithm, the adjacency matrix needs to be converted to a network.

In this data structure, each INcCRNA is represented as a “node” and each non-zero element of the



adjacency matrix represents an “edge” between two nodes, describing their similarity. The
Louvain algorithm attempts to find communities of nodes having significantly more edges between
the nodes within a given community than edges connecting nodes between different communities.
Finally, we label each node with the name of the transcript and the community it's found in before
saving the graph for visualization. In addition to saving the full graph, we will also produce a two-
column csv file where the first column is the name of the IncRNA and the second is the community
to which the IncRNA belongs.

import numpy as np

import networkx

import igraph

import louvain

adj = 'v22 adj 13.csv'
adjacency = pd.read csv(adj, index col=0)
graph = networkx. from pandas dataframe (adjacency)

adjacency = None (see note 11)

# Save subgraph

subgraphs = list (networkx.connected component subgraphs (graph))
graph sizes = [sub.size() for sub in subgraphs]

main sub = subgraphs|[graph sizes.index (max(graph sizes))]

gml path = 'v22 sub.gml'

networkx.write gml (main sub, gml path) (see note 12)

# Find communities with Louvain

gamma = 1 (see note 13)



ig graph = igraph.Graph.Read GML (gml path)
partition = louvain.find partition(
ig graph, louvain.RBConfigurationVertexPartition,

weights="'weight', resolution parameter=gamma)

n _comms = 5 (see note 14)
zipped = zip(main sub.nodes (), partition.membership)
name2group = {k:v 1f v <= n comms-1 else n comms for k, v in zipped}

networkx.set node attributes(
main sub, name='Group', values=nameZgroup)

networkx.write gml (main sub, gml path)

# Save 1ncRNA communities to csv
with open('communities.csv') as out file:
for 1IncRNA in graph.nodes():
group = nameZ2group.get (1ncRNA, n comms-1)

out file.write (f'{1lncRNA}, {group}\n"')

Again, the thresholding value is experiment specific. For that reason, it is a required argument for
the command line script. In the instance below, we also save the full gml file, with the “-g" flag,

and the two-column csv file listing INcRNAs and communities, with the “-c" flag:

$ seekr graph v22 adj.csv 0.13 -g v22 sub.gml -c v22 comms.csv

3.3.4 Visualize in Gephi
Gephi is open-source software that is useful for visualizing INncRNA community graphs. On launch,
Gephi will provide you with a "Welcome" pop-up window. In the "New Project" section, click "Open

Graph File". Select "'v22_sub.gml’. If loaded correctly, you will receive an "Import report" listing



the number of nodes and edges as well as other graph details. Click "OK". In the center of the
main application window, you should see a small black circle. This is the default layout and
coloring of the graph. Next, we'll color and properly layout the nodes. In the top left of the window,
there will be an "Appearance" section. Click "Nodes" -> "Partition" -> "Choose an attribute" ->
"Group" -> "Apply". After a few seconds, the nodes of the graph should be colored by group. On
the bottom left, there is a section called "Layout". Click "Choose a layout" -> "Yifan Hu" -> "Run".
Running the layout will take time. Progress can be tracked in the bottom right. Once finished, save
the image by clicking: "File" -> "Export" -> "SVG/PDF/PNG file" -> "Options". Set "Width" and
"Height" to 4096. Click "OK". Name your file and click "Okay" again. Saving the image will also

some take time.

3.4) SEEKR Python

The command line tools are a convenient way to use SEEKR. However, to gain additional
flexibility and performance, one can also consider using SEEKR as a Python module. The code
below demonstrates the same pipeline as above (from downloading a fasta file from GENCODE
to producing a csv file of IncRNA communities), but runs >10x faster than the command line tools:
import numpy as np

import pandas as pd

from seekr import fasta, kmer counts, graph

downloader = fasta.Downloader ()
downloader.get gencode (biotype='lncRNA', release='22")
fasta path = 'v22 IncRNA.fa'

fastall path = 'v22-01.fa'

maker = fasta.Maker (fasta path, fastaOl path)

maker.filterl ()



names = fasta.Maker (fastall path) .names

counter = kmer counts.BasicCounter (fastaOl path, log2=False)
counter.get counts ()

adj = pd.DataFrame (np.corrcoef (counter.counts), names, names)
comms_ path = 'comms.csv'

gm = graph.Maker (adj, csv_path=comms path, threshold=0.13,
leiden=False)

gm.make gml csv files()

3.5) Scaling k-mer profiles by protein-binding motifs (Positional Weight Matrices)
One of the underlying assumptions of SEEKR is that IncRNAs derive function from the proteins
that they bind. Therefore, a logical step is to utilize the k-mer profile of a given sequence to predict
proteins that may bind that sequence. To do this, one can scale k-mer profiles by position weight
matrix probabilities (PWMs). We outline this methodology below.

Our code is written to input PWMs in the format provided by the CisBP-RNA database [57].
To download, navigate to http://cisbp-rna.ccbr.utoronto.ca/bulk.php. In ‘By Species’, select
Homo_sapiens, then click ‘Download Species Archive’ and in the new page click ‘Download’.
However, any PWM can be used if formatted correctly. Individual PWMs must be tab separated
and saved in a .txt file. Each PWM must contain a header row with entries [Pos, A,C,G,U]. The
‘Pos’ column contains integers representing the position within the PWM. Each row must sum to
1, excluding the index column, thereby representing the probability of finding each nucleotide at
each position within the motif.

This code iterates through the PWM files in pwm directory and calculates the probability
of observing all k-mers within each motif. The probability of observing a k-mer in a motif is

calculated as the independent probability of observing each nucleotide of the k-mer at the



corresponding position within the motif. The weight is then the sum of possible frames that a k-
mer could occur in, for example a 5-mer could fall in two different frames in a 6bp motif. Prior to
running the code below, users need to derive k-mer counts in the INcRNAs of interest, as specified

in Section 3.1.

import pandas as pd
import numpy as np
from itertools import product

from pathlib import Path

# path to PWMs

pwm_directory 'cisbp pwms/pwms all motifs/'

pwm directory = Path (pwm directory)

# k-mer counts are produced by seekr kmer counts (See section 3.1)

counts path = 'v22_6mers.csv'

k = 5 (see note 15)
kmers = [''.join(p) for p in product ('AGTC', repeat=k)] (see note 16)
z scores = pd.read csv(counts path, index col=0)
score dict = {}
for pwm path in pwm directory.glob('*.txt'):
try:
pwm = pd.read csv(pwm path, sep='\t')

except pd.errors.EmptyDataError:



print (f'The motif file {pwm path} is empty. Skipping.')
continue
pwm.drop ('Pos', axis=1, inplace=True)
pwm = pwm.rename (columns={'U': 'T'}).to dict()
kmer2weight = dict(zip (kmers, np.zeros(4 ** k)))
motif len = len(pwm['A']).
if motif len < k: (see note 17)
kmers within kmer = [([kmer[i:i+4] for i in range(k-4+1)],
kmer) for kmer in kmers]
n _kmers = motif len - 4 + 1
for sub kmers, kmer in kmers within kmer:
for sub kmer in sub kmers:
for frame in range(n_ kmers):
weight = 1
for pos, nucleotide in enumerate (sub kmer):
weight *= pwm[nucleotide] [pos + frame]
kmer2weight [kmer] += weight
else:
for kmer in kmers:
n _kmers = motif len - k + 1
for frame in range(n kmers):
weight = 1
for pos, nucleotide in enumerate (kmer) :
weight *= pwm[nucleotide] [pos+frame]

kmer2weight [kmer] += weight



sorted weights = np.array([kmer2weight[k] for k in

z scores.columns])
weighted z scores = z scores.values.copy() * sorted weights
scores sums = weilghted z scores.sum(axis=1)

score dict[pwm path.name] = scores sums

#save output

out df = pd.DataFrame.from dict (score dict, orient='index',
columns=z_ scores.index)

out path = 'pwm weighted SEEKR.csv'

out df.to csv(out path)

3.5.1 Using the command line tool (specify k-mer length if not using k = 5):
$ seekr pwm cisbp pwms/pwms_all motifs v22 émers.csv -k 6 -o

pwm weighted SEEKR.csv

3.6) Scanning IncRNAs for domains of related k-mer contents

This program is designed to scan a set of fasta sequences, or ‘targets’, for regions of high
correlation to a set of sequences that we define as the ‘query’ sequences. Typical query
sequences might represent functional domains in INcRNAs of interest. Targets are broken up into
sliding windows with length and slide designated by the user. Correlations from each tile are then
compared against a ‘reference’ set of sequences that are specified by the user.

This program iterates through k-mer counting three times, which we show explicitly below for
completeness. The first iteration calculates the k-mer profile of a query sequence, the second

iteration calculates the k-mer profiles for each tile in the target sequence, and the final iteration



calculates the k-mer profile for each transcript in the reference set of sequences and correlates
them with the query k-mer profiles. This last calculation yields a distribution of Pearon’s correlation

values from which we can derive the ranks of our targets relative to the queries.

import pandas as pd

import numpy as np

from itertools import product
from collections import defaultdict
from scipy.stats import pearsonr

from scipy.stats import percentileofscore

from seekr.kmer counts import BasicCounter

from seekr.fasta reader import Reader

# Path to a query of interest (in this example, the sequence of repeat
# B in the 1ncRNA Xist)

query path = 'mml0 xist repeatB.fa'

# This performs standard SEEKR for the query

query = Reader (query path) .get seqgs() [0]

window = 1000 (see note 18)

slide = 100

k =5

kmers = [''.join(p) for p in product ('ATCG', repeat=k)]

k map = dict (zip(kmers, range(4**k)))



mean path, std path = 'mean.npy', 'std.npy'

mean = np.loa

d (mean path)

std = np.load(std path)

query counter
query counter
query counter

query counts

g vs_t rvals

= BasicCounter (k=k, mean=mean, std=std)

.segs = [query]

.get counts ()

= query counter.counts

=[]

target path = 'mml0 kcnglotl.fa'

target = Reader (target path) .get seqgs() [0]

tiles = []

for i in rang
end = 1 +
tiles.app

tiles[-1] +=

tile counter
tile counter.

tile counter

g vs_t rvals
tile counter.

g vs ref rval

e (0, len(target), slide):

window

end (target[i:

target[end:]

end])

= BasicCounter (k=k, mean=mean, std=std)

seqgs = tiles

.get counts ()

= np.array ([pearsonr (query counts[0],

counts[1i]) [0]

s = []

for i in range(len(tiles))])



ref path = 'v22-01.fa'

ref = Reader (ref path).get segs()

ref counter = BasicCounter (k=k, mean=mean, std=std)
ref counter.segs = ref

ref counter.get counts/()

ref counts = ref counter.counts

g vs ref rvals = np.array([pearsonr(query counts[0], ref counts[i]) [O]
for i in range (len(ref))])
ranks = []
for tile corr in g vs t rvals:
ranks.append (percentileofscore(q vs ref rvals, tile corr,

kind='rank'))

query target df = pd.DataFrame (g vs t rvals)
query target df out = 'query target pearson.csv'
query target df.to csv(query target df out)
ranks df = pd.DataFrame (ranks)

ranks df path = 'ranks.csv'

ranks df.to csv(ranks df path)

3.6.1 Command line usage

This tool requires several pieces of data. 1) A fasta file containing one or more query sequences,
2) A second fasta file containing one or more target sequences which will be tiled into domains,
3) The mean and standard deviation vectors for normalization (e.g. appropriate output from

‘seekr_norm_vectors’). You can then select the locations for one or both of the possible output



files with the ‘-r' and the ‘-p' flags. The ‘-r’ flag prints a matrix of Pearson’s r values describing the
similarity between each query and each tile in each target, and the ‘-p’ flag prints a corresponding
matrix of the percentile rankings of the Pearson’s r values relative to a reference set of sequences.
If you use the ‘-p’ flag you must also use the ‘-rp’ flag, which specifies the reference set of
sequences to be used in percentile calculations; for example, ‘v22-01.fa’. Also, ensure that the ‘-

k' flags passed to “seekr_norm_vectors’ and “seekr_domain_pearson’ are the same:

$ seekr norm vectors v22-0l1.fa -k 5
$ seekr domain pearson mml0 xist repeatB.fa mml0 kcnglotl.fa mean.npy

std.npy -rp v22-01.fa -k 5 -r r values.csv -p percentiles.csv

4) Notes

1. If you manually download this file from GENCODE’s website, it will be called
“gencode.v22.IncRNA_transcripts.fa”.

2. In human, there are a few genomic regions where the canonical isoform is not -001, but -
*01 instead, usually -201. It is worth manually examining the GENCODE annotations to
ensure that your INcCRNA spliceform of interest is included in your analyses.

3. While it is possible to directly increment the numpy array for each k-mer, randomly
accessing the array is slow when done billions of times. Instead, a dictionary is used to
collect the counts for a single transcript. That way, each element of the array can be
accessed only once.

4. Because we want to count overlapping k-mers we cannot use Python's built-in “count’
method, and need to manually iterate over the strings ourselves.

5. k-mers that contain non-ACGT nucleotides (eg. ATCGGN) are skipped.

6. In our original publication describing SEEKR, log normalization was not used. In a limited

number of tests, we have found that log normalizing k-mer counts prior to performing



10.

11

12.

13.

Pearson’s correlation mildly improves our ability to detect biological meaningful trends. In
general, log normalization is an appropriate way to reduce skew in data, and k-mer counts,
especially in repetitive regions of RNA, are often skewed. If log2 normalization is not
desired, pass the "-nl’ flag to “seekr_kmer_counts’.

GENCODE transcript names are not necessarily unique. To be able to use names as the
index of an R DataFrame, 'B' is appended to transcript names that have already occurred.
This array is approximately 250 million elements (16,000 by 16,000 r-values). For a
significant efficiency increase (~50x speed, 2x space), consider using the binary flags "--
binary_input’ and/or --binary_output’™ when running seekr pearson. Also note that
usage of these flags may require additional adjustment to flags in other stages of the
SEEKR pipeline.

The 0.13 Pearson value as a threshold was chosen as a balance between computational
efficiency and information retention. In GENCODE v22, the Pearson’s value of 0.13 is
approximately two standard deviations above the mean similarity between all pairwise
IncRNA comparisons. Overall, we found little to no difference in community definition,
correlation with IncCRNA localization, or ability to predict protein-binding patterns over a
range of limit values.

The diagonal of the matrix contains all ‘1’ values, since the k-mer profile of a transcript
versus itself is a perfect correlation. These edges are not useful for defining communities,

so we remove them.

. This is just done to clear some memory.

Writing out to disk at this point is simply used as a way to convert between a networkx
graph and an igraph graph. The igraph version is needed for running louvain. There are
likely better ways of doing this.

Gamma is the resolution parameter for the Louvain algorithm, and is used to tune how

many communities are found. Gamma must be greater than 0, and the larger the value,



14.

15.

16.

17.

18.

the more communities will be created; consequentially, community sizes are smaller at
larger gamma values. We chose to stay with the default resolution parameter, 1, which
was supported by CHAMP [58]. CHAMP is an algorithm which can help provide context
for which values of gamma might be most appropriate for a given graph.

Choosing the number of communities can be difficult. We used an estimate based on the
hierarchical heatmap, in combination with the size of the communities. In our original
publication of SEEKR, community 6 was significantly smaller than community 5 (relative
to the ratio between, community 5 and 4, or 4 and 3, etc.; [46]). n_communities is defined
here so we can cap the number of communities found by the Louvain algorithm before
adding values to the main subgraph below.

k = 5 is a reasonable default because it tends to strike a balance between decreasing
sparsity in k-mer profiles while still retaining good discrimination between queries and
targets.

Nucleotide entries in this list must be in exactly the same order as used in Section 3.1,
‘AGTC'.

This loop is designed to find all 4-mers within the larger k-mer if the value of k is larger
than the length of the motif. For example, the 5-mer ATCGT does not exist within a 4 base
pair motif, but two 4-mers within the 5-mer, ATCG and TCGT can fit within a 4 base pair
motif. This loop calculates the probabilities of observing the 4-mers separately and then
sums the result. No motif in CisBP-RNA database is < 4 base pairs, hence the default of
k=4.

The window and slide variables can be set to any positive integer. In our work, we have
found that a window approximately the size of the query features, such as the tandem
repeat domains of Xist, provides good results. In general, increasing the window size
smoothens the resulting data whereas decreasing window size gives more detail but

increases noise. The slide is best adjusted as a function of the size of your target dataset.



If only a couple sequences are being considered, a slide of 1 may be appropriate, but if
the study is over the entire transcriptome or otherwise genome-wide, then larger slides

can reduce compute time and storage space exponentially.
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